
January 2011 Master Load and Update 
 
 
 
The following is a list of changes incorporated in this update.  The changes are 
listed in reverse chronological order, so that the most recent changes are listed 
first. 
 
 
May 1, 2013 
Real-time program – the real-time program can now send output to viewers via 
WiFi.  Note that the viewer needs software that can receive testimony from the 
reporter via WiFi.  It is possible to use some browsers on computers, cell phones, 
android devices to receive the testimony from reporters.  WiFi is built into virtually 
all computers, smart phones, iPads and Android devices.  The only other 
hardware required to send out your real-time output to viewers is a portable WiFi 
router.   
 
November 21, 2012 
• File Management program – when you choose the Kindle as removable 

media, the File Management program will automatically choose the 
“documents” folder on the Kindle.  If you copy a .TXT (ASCII) or .PDF file to 
the “documents” folder on the Kindle, you will be able to read, make 
bookmarks and notes of that file. 

 

 
 
• Real-Time program – You can now elect to have the real-program show steno 

briefs.  If you choose this option, then when you write an outline that is three 
or more strokes, the real-time program will search your personal dictionary 
and any job dictionaries for that job to see if you have already defined a one 
stroke outline for that word.  In addition you have the option of searching third 
party job dictionaries, such as Mark Kislingbury’s dictionary, for briefs.  To 
view the briefs: 
1. When you have the real-time program open, click on the View menu, then 

click View Briefs/Fast Defines (or you can press the F7 function key. 
2. Now click the Preferences icon on the toolbar.  Then click the Briefs 

button.  Now check the box “Show Briefs”. 



 
 

3. At this point you can also add job dictionaries to be searched for briefs.  
Note that the job dictionaries you add here are not used in the translation, 
they are just searched for briefs. 

4. Click the Help button for more detailed information. 
5. We have a job dictionary (CommonBriefs) containing briefs that you can 

download from our web site.  If you download this job dictionary, you will 
need to save it in your user folder along with all of your other files.  Here is 
a link to CommonBriefs.job:  
http://www.aristocat.com/support/CommonBriefs.job  

 
• Various Programs - You can now insert foreign characters (señor, über) and 

other special characters such as trademark symbols (™), copyright symbols 
(©), etc. in your dictionary or in Edit.  When you are making a define in Edit or 
editing a dictionary entry, you will see a menu at the top of that dialog box 
starting with “Format     View      Special Characters”. 



 
 
The Format menu allows you to insert bold, italic, underline and other symbols in 
the translation.  The View menu allows you to get the definition of the word in the 
translation or look it up on the Internet (same as a right-click on a word in Edit).  
The Special Characters menu allows you to insert foreign characters and 
symbols in the translation. 
 
 
September 13, 2012 
• Real-time program: 

1. You can now search for a previous answer or question.  On the toolbar 
there are two icons, LastA and LastQ.  You can click on either icon to 
search for the last answer or question that has scrolled off the real-time 
screen.  You can also make a definition (RT-LASTA and RT-LASTQ) in 
your personal dictionary so that you can do the search using your writer.  
You can repeat the search by clicking on the icon again or using your 
writer.  When you search for the last answer or question, you will be in the 
scroll mode.  To exit the scroll mode press the ESCape key on your 
computer keyboard or just start writing on your writer. 

2. The RT-FASTDEFINE has been enhanced so that you can specify what 
steno is automatically assigned to the define.  To set the steno options, 
click on the Preferences toolbar on the real-time screen and then click the 
Briefs Option button.  See the chapter on real-time for detailed information 
on using RT-FASTDEFINE. 

3. A new RT command has been added.  The RT-INTERRUPTP command 
works similar to the Interrupt command in Edit, except that it works 
backward.  That is, when you write your steno for the command, it inserts 
dashes at the beginning of the current question, answer or colloquy 
speaker and then searches for the previous question, answer or colloquy 
speaker and inserts dashes at the end of that paragraph.  For example 
let’s look at the following: 



Q.     When? 
A.     Never. 
Q.     Did you wear white after Labor Day? 

 If you write your steno for RT-INTERRUPTP anywhere in the second 
question, the text will be changed to: 

Q.     When_-- 
A.     Never. 
Q.     -- did you wear white after Labor Day? 

4. There is now an option to have audio sync automatically start recording 
when the real-time program starts.  To set this option, click on the 
Preferences toolbar on the real-time screen and then click the AVSync 
Options button.   

• Special Characters – Several programs have been changed to allow the use 
of special characters such as the foreign character set (è, ñ, ü), copyright (©), 
paragraph (¶) and other special characters.  These characters can be 
globaled in Edit, put in your personal dictionary and include files.  At the top of 
several dialog boxes in several programs there will be a menu that reads 
“Format      View      Special Characters”.  To insert a character click on the 
Special Characters menu, then click on the appropriate submenus until you 
find the character you want to insert. 

 
 
March 25, 2012 
• Real-time program – You are now able to have a scopist edit your real-time 

while you are writing.  Go to the Real-time chapter in the User’s manual for 
details on how to have a scopist edit your real-time. 

• Real-time and Translation programs – you can have the translation programs 
change an answer bank to a speaker (THE WITNESS, THE DEFENDANT, 
etc.) after a colloquy.  There is a box you can check on the Translation and 
Real-time Options dialog box to have the answer bank changed to a speaker. 

• Changes have been made to the Print program to allow you to: 
1. Specify the number of columns for the word index.  
2. Print the words in the word index in a different color. 
3. Print questions, answers in bold or in color. 
4. Print the time stamps in a different font or color. 
5. You can elect to print in color for PDF files only. 

• You can now elect to print in color for PDF files in the Multipag program.  
To set the above options in Print and Multipag, open your information file, 
click on the Hdrs/Ftrs tab then click on the Print Font or Multipag button.  
Click on the Help button for detailed information on the above options. 

• File Management program – an enhancement has been made to the file 
management program that allows you to easily archive note file floppy 
diskettes to other removable media such as CDs/DVDs, USB thumb drives, 
USB hard drives, etc.  While this feature was designed primarily to archive 
note files diskettes from SmartWriters, Stenturas , Miras and Fusions, it can 
also be used to copy diskettes used to archive .wrk files, etc.  To use this new 



feature, click on the Note Files menu, then click on the Archive Diskettes 
menu.  Now you can click the Help button to get help on using the options.  
Note:  This first version does not copy files to CDs with the Windows XP 
operating system.  We are working on a solution to this. 

 
 
October 3, 2011 
• Stentura 8000 Conversion Program – two enhancements have been made to 

the Stentura 8000 Dictionary Conversion Program: 
1. It now works with Windows 64-bit operating systems 
2. You now have the option of sending the converted dictionary to a drive 

other than the A: or B: drive.  This allows customers who have replaced 
their floppy drive with a flippy drive to use the conversion program. 

• Real-time program – several enhancements have been made to the real-time 
program: 
1. Two options have been added to street types.  Remember Street Names 

and Add to Job Dictionary.   Using the example “423 northeast clay 
street”, if you check the Remember Street Names box, then the real-time 
program will also cap northeast clay avenue, clay avenue and northeast 
clay.  If you check the Add to Job Dictionary, then 423 Northeast Clay 
Avenue, Northeast Clay Avenue, Northeast Clay and Clay Avenue will be 
added to the job dictionary.  If you do not check the Remember Street 
Names box, but you do check the Add to Job Dictionary box, then only 
423 Northeast Clay Avenue will be added to the job dictionary. 

2. You can now create conflicts that will be automatically be resolved 
depending on what follows the conflict.  For example, you can create the 
conflict {exhibit\Exhibit>#}, then if a number or a single letter follows the 
conflict, then the conflict will be resolved to Exhibit.  If a number or single 
letter does not follow the conflict, then the conflict will be resolved to 
exhibit.  So ‘{exhibit\Exhibit>#} 10’ resolves to ‘Exhibit 10’, 
‘{exhibit\Exhibit>#} b’ resolves to ‘Exhibit B’ and ‘{exhibit\Exhibit>#} is’ 
resolves to ‘exhibit is’.  Note that you have to have the ‘>#’ as part of the 
conflict so that the real-time program knows which conflict to choose 
depending on what follows the conflict.  In addition, there is the option of 
having a letter follow the # to format the number.  Example:  
{volume\Volume>#R} where the R that follows the # will format the number 
as upper case Roman Numeral.  Other formatting options are D for date, T 
for time, r for lower case Roman Numeral, O for ordinal, s for lower case 
spelled out (one), S for initial cap spelled out (One) and A for Arabic.  
Other conflict examples include {box\Box>#}, {suite\Suite>#}, 
{highway\Highway>#}, {apartment\Apartment>#}, {exhibit number\Exhibit 
Number>#}, etc.   This conflict option works with both the real-time and 
regular translation programs.  Hint:  To try this out, pick just one example 
and put it in your personal dictionary. 

3. An AutoPause option for audio sync has been added.  The AutoPause 
option will automatically pause the recording after a certain number of 



seconds if you don’t write on your writer.  To set this option, when the real-
time screen is open, click on the AVSync menu, then click AVSync 
Options.  Then put the number of seconds you want the auto pause to 
start if you haven’t written anything.  If this value is 0 (zero), then it will not 
auto pause.  If you have a non-zero value, then the recording will 
automatically restart when you start writing again.  A non-zero value will 
cause the Automatic Un-Pause box to be checked.  It is recommended 
that you don’t set this value too low (less than 10 seconds?) until you have 
had used it for awhile to see how it works for you. 

• A couple of minor glitches have been fixed. 
 
 
 
September 7, 2011 
The proofreading functionality has been implemented in the Edit program.  This 
should eliminate the need to run the current proofread program to check for 
errors in the transcript.  The main advantage of having it in the Edit program is 
that you can exit the proofread function at any time, make any necessary edit 
changes and then resume proofreading at the point where you left off.   
 
Before you proofread for the first time, you should click on the Edit Preferences 
menu (or tool bar), then click on the Proofread button and set your proofread 
preferences.  Click the Help button for information on the various proofread 
options. 
 
Once you have set the proofread options, to start proofreading, click on the Tools 
menu then click Proofread or click the Proofread icon on the toolbar.  The proof 
reading will start on the page and line where your cursor is.  So you can save out 
of Edit and when you come back in, you can start proofreading where you left off.  
The proofreading process should work exactly like the old proofread program.  It 
will use the update dictionary that you created in the old proofread program. 
 
Note:  This is a fairly major change to the Edit program.  It is recommended that 
you save out of Edit after you have done a lot of editing and then come back in 
and start proofreading.  You do not have to use the new proofread functionality.  
You can continue to use the old proofread program. 
 
We do not plan on many any more changes to the old proofread program, but we 
welcome suggestions on any enhancements to the new proofread functionality 
that is now built into the Edit program. 
 
 
June 21, 2011 

• A critical update to the Edit program.  A problem that only seems to occur 
with Windows XP, Service Pack 3 causes the Edit program to abnormally 



terminate.  It is highly recommended that you download and install this 
update regardless of what version of Windows you are using. 

• A change was made to the real-time program to make it work better with 
CaseViewNet.   

• Print and Multipag – an option to change the appearance of quotes, 
apostrophes and dashes was made.  If you check the box “Format:  “ ‘  --“, 
then straight quotes are changed to curly quotes, straight apostrophe to 
curly apostrophe and dashes to a solid line 

 
 
May 15, 2011 

• Dictionary Management program – when you do an English search while 
editing a job dictionary, your personal dictionary or batch file, there is a 
new option “Show All Occurrences”.  If you check this box, then a new 
window will open and all entries that match your English search will 
display in this new window.  You can scroll through the entries and if you 
double click on an entry, it will take you to that entry in your job or 
personal dictionary or batch file.  You can then edit that entry.  To close 
out the “Show All” window, click on the X in the upper right corner or press 
the ESCape key. 

• Real-time program – a split file feature has been added.  The split file 
feature allows you to dynamically split out portions of the real-time session 
while it is still active.  The split out section can then be attached to an e-
mail or copied to an external drive.  While it was designed to allow you to 
give portions of the real-time session to a scopist so they can be editing 
portions of the real-time while the reporter is still writing, you can also use  
the split file feature to back up the real-time files.  For details on the split 
file feature, see the RT-SPLIT command in the User’s Manual. 

 
 
May 2, 2011 

• Dictionary Management program – There is now a Preferences toolbar 
option in the Edit Personal Dictionary that allows you to have any changes 
you make to your personal dictionary to be updated when you exit the Edit 
Personal Dictionary.  If you want to enable this feature, check the box 
“Update Edited Entries”.  By checking this box, any changes you make to 
your personal dictionary will be updated immediately.  Note that there is a 
similar option on the Preferences toolbar in the Review Batch File Entries.  
Click the Help button for detailed instructions. 

• Read program – two changes have been made to the Read program: 
1. For those customers who are using the Diamante, élan Mira/Fusion 

with the Date/Time option or the ProCAT Stylus there is now a Change 
Month button which allows you to quickly advance to the next month to 
read your note files. 



2. If you are using a newer writer which uses media such as an SD card, 
there is an option to quickly and temporarily change your writer type if 
you need to read an old job from a floppy.   

 
Click on the Help button for detailed instructions on how to use these new 
features. 

 
 
February 25, 2011 

• View Notes program – You can now export a note file to the RTF/CRE 
format.  When you have a note file open in the View Notes program, click 
the File menu then click Export to RTF/CRE. 

• Dictionary Management program – When you update your personal 
dictionary, it will also update the RTF/CRE version of your personal 
dictionary.  This will save you a step when you go to load your personal 
dictionary on your writer. 

• Real-time program 
1. A toolbar has been added to the real-time program.  You can turn off 

the toolbar by clicking on the View menu then click the Hide Toolbar 
menu.  You can turn it back on by repeating the above step. 

2. Playback of the audio sync sound file has been enhanced.  There is a 
Play button on the toolbar.  When you click on the Play button it will 
start playing back the sound beginning at the top of the screen.  To 
stop playing back the sound, click the Stop button.  You can also play 
back the sound at a particular point by a single right-click on the line of 
text where you want to start playing back the sound.  To stop the 
playback, you can right-click again or click the Stop button.  While you 
are playing back the sound, the recording will automatically be paused 
and when you stop playing back the sound, the recording will 
automatically resume. 

 
 
February 7, 2011 

This is the first version of the January 2011 software.  This first version is the 
same as the latest version of the September 2009 Master Load and Update.  
Note that we are using a newer version of the PDF conversion software that 
should allow us to enhance the word index in the Print and Multipag 
programs.   
 

 
Note:  After you install this master load and click the Finish button, the 
installation will then install a PDF printer driver (Amyuni Document Converter).  A 
window will open and you will see the process of copying files and at the end of 
the installation of the PDF driver, you should see a message indicating the printer 
was successfully installed.  When you call in for the install code, we can guide 
you through this process. 



 
 
Important Note:  You will need an install code to install a master load.  You do 
not need an install code to install an update.  Please call AristoCAT at 1-800-
727-4786 when you are ready to install to get the install code. 
 
 
 


